Kernel for

OLM to PST

Installation &
Configuration Guide

Kernel for OLM to PST

Installation & Configuration Guide

Table of Contents
1.

2.

4.

5.

6.

7.

About Kernel for OLM to PST................................................................................................................................................. 5
1.1

About the Manual ........................................................................................................................................................... 5

1.2

Introduction to Kernel for OLM to PST ......................................................................................................................... 5

1.3

Salient Features............................................................................................................................................................... 6

1.4

Benefits of Kernel for OLM to PST .............................................................................................................................. 6

1.5

System Requirements ..................................................................................................................................................... 6

Getting started with the User Interface .................................................................................................................................. 9
2.1

Welcome Screen of the Software ................................................................................................................................... 9

2.2

Menu Bar ...................................................................................................................................................................... 10

2.3

Tool Bar ........................................................................................................................................................................ 11

2.4

Left Pane ....................................................................................................................................................................... 11

2.5

Right Pane .................................................................................................................................................................... 12

Using Kernel for OLM to PST ............................................................................................................................................... 16
4.1

Converting OLM File ..................................................................................................................................................... 16

4.2

Searching OLM File ..................................................................................................................................................... 21

4.3

Saving Output File ........................................................................................................................................................ 26

Download, Purchase and Register .......................................................................................................................................... 44
5.1

Free Trial Download ..................................................................................................................................................... 44

5.2

Purchase & Register ..................................................................................................................................................... 44

5.3

Support .......................................................................................................................................................................... 44

Troubleshooting .................................................................................................................................................................... 46
6.1

Common Issues ............................................................................................................................................................. 46

6.2

Frequently Asked Questions ........................................................................................................................................ 46

Legal Notices ........................................................................................................................................................................ 47
7.1

Copyright Notice ........................................................................................................................................................... 47

7.2

Trademarks ................................................................................................................................................................... 47

7.3

Disclaimer ..................................................................................................................................................................... 47

7.4

License Agreement ....................................................................................................................................................... 47

© KernelApps Private Limited

Kernel for OLM to PST

Installation & Configuration Guide

Table of Figures
Figure 2.1: Welcome Screen of Kernel for OLM to PST Software.................................................................................................. 9
Figure 2.2: File Menu .................................................................................................................................................................... 10
Figure 2.3: View Menu ................................................................................................................................................................. 10
Figure 2.4: Help Menu .................................................................................................................................................................. 11
Figure 2.5: Left Pane ............................................................................................................................................................. 12
Figure 2.6: Right Pane displaying items of a selected folder .......................................................................................................... 12
Figure 2.7: Right Pane displaying details of selected email item .......................................................................................... 13
Figure 4.1: Main Window of the software after launching the product ......................................................................................... 16
Figure 4.2: Search OLM File Interface ................................................................................................................................. 17
Figure 4.3: Searching for OLM file............................................................................................................................................................ 18
Figure 4.4: Enlisting the files found in the selected drive ..................................................................................................................... 18
Figure 4.5: Figure depicting selected OLM file....................................................................................................................................... 19
Figure 4.6: Displaying successful completion of scanning process ....................................................................................... 20
Figure 4.7: Displaying details of retrieved data..................................................................................................................... 21
Figure 4.8: Searching for OLM Files.................................................................................................................................................. 22
Figure 4.9: Specifying the Search Criteria ......................................................................................................................................... 23
Figure 4.10: Searching in Progress ........................................................................................................................................ 24
Figure 4.11: Displaying Searched Items .............................................................................................................................................. 25
Figure 4.12: Saving Options for Searched Items................................................................................................................... 26
Figure 4.13: Selecting PST File option to convert the OLM file...................................................................................... 27
Figure 4.14: Applying filters to the OLM data .............................................................................................................................. 28
Figure 4.15: PST file Split options ................................................................................................................................................... 29
Figure 4.16: Selecting a destination path to save the PST file ........................................................................................................ 30
Figure 4.17: Specifying a location to save the PST file .......................................................................................................... 31
Figure 4.18: Saving the PST files to exact location ..................................................................................................................... 31
Figure 4.19: Notification displayed after saving the file .............................................................................................................. 32
Figure 4.20: Selecting MSG option from the Output type .....................................................................................................................33

© KernelApps Private Limited

Kernel for OLM to PST

Installation & Configuration Guide

Figure 4.21: Applying specific filters to the OLM file ...................................................................................................................... 34
Figure 4.22: Selecting a destination path to save the MSG file .............................................................................................. 35
Figure 4.23: Specifying the location for saving the MSG file ................................................................................................. 36
Figure 4.24: Software converting OLM data to MSG format ................................................................................................ 37
Figure 4.25: Showing the saved result at desired location ..................................................................................................... 38
Figure 4.26: Selecting EML option from Output type .................................................................................................................. 39
Figure 4.27: Applying specific filters to the OLM data......................................................................................................................... 40
Figure 4.28: Specifying the Saving Path Location for saving the EML files .................................................................................. 41
Figure 4.29: Finalizing a location to save EML file ................................................................................................................ 41
Figure 4.30: Software saving OLM file to EML format ............................................................................................................. 42
Figure 4.31: Displaying the location for saved EML files .......................................................................................................... 43

© KernelApps Private Limited

Kernel for OLM to PST

Installation & Configuration Guide

1. About Kernel for OLM to PST
1.1 About the Manual
Welcome to the user manual of Kernel for OLM to PST, an appropriate tool that allows accessing Outlook for
Mac emails in MS Outlook platform. The tool easily imports Outlook for Mac data into MS Outlook by converting
the user mailboxes. The tool efficiently performs email migration as well as recovers corrupted OLM files. The
utility allows user previewing the recovered data and restores it in a new PST file that can be easily accessed
with MS Outlook. This user manual guides users about using the tool effectively. It is recommended that novice
as well as experienced users should carefully go through this user manual before using the software. A user
who is well aware of the software can even use table of contents for finding the particular portion of manual.
The table of contents enlists all the sections described in this user manual from where one can navigate through
its different sections. The user manual consists of step-by- step guidelines for using Kernel for OLM to PST.
The user manual consists of the following sections:
About Kernel for OLM to PST
Getting started with the User Interface
Installing and Uninstalling Kernel for OLM to PST
Using Kernel for OLM to PST
Download, Purchase and Register
Troubleshooting
Legal Notices

1.2 Introduction to Kernel for OLM to PST
Kernel for OLM to PST is an advanced, effective, and powerful software that converts Outlook for Mac emails
to MS Outlook accurately and flawlessly. The software converts all user mailbox data including emails,
contacts, calendars, tasks, notes, journals, appointments, etc. to MS Outlook PST file format. The software
offers easy-to-use, highly interactive, self-descriptive, user-friendly graphical user interface such that nontechnical users can easily operate it without any technical training. The software is embedded with advanced
algorithms for performing easy email migration process of conversion from OLM to PST. The software
performs the entire conversion process in three simple steps – Takes the OLM file as an input, Recovers data
from the OLM file and Restores the recovered data in a new PST file that can be accessed with MS Outlook.
The software is available as a free trial version such that users can evaluate the features, functionalities and
capabilities of the software before making the actual purchase.
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1.3 Salient Features
Some of the key features of Kernel for OLM to PST are as follows:
Efficiently converts Outlook for Mac emails to MS Outlook platform.
Recovers corrupted or damaged OLM file and extracts data from it.
Recovers emails, contacts, calendars, hyperlinks, email attachments and others from OLM file with
complete accuracy.
Displays preview of recovered data in a tree-like structure.
User can terminate the current process while generating items from recovered folder.
Allows user to save the recovered folder items as HTML file.
Maintains original structure, formatting, properties and Meta data after conversion.
Allows user to save the recovered data date-wise as per user‟s requirement.
Offers options for saving the recovered items in PST, MSG and EML file formats.
Supports all versions of MS Outlook and Outlook for Mac.
Offers easy-to-use, simple, self-descriptive, attractive graphical user interface. No technical skills
required for operating the software.
Supports 32-bit and 64-bit Windows operating systems.
Available as free demo version.
Offers round-the-clock technical support.

1.4 Benefits of Kernel for OLM to PST
Kernel for OLM to PST offers numerous benefits to the users. Some of them are as follows:
Allows viewing Outlook for Mac emails in Microsoft Windows platform.
Reduces installation cost of Mac Operating systems for accessing Outlook for Mac emails.
Outlook for Mac OLM files can be accessed outside the Mac environment.
Helps creating backups of OLM files.

1.5 System Requirements
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Your computer system must have the appropriate configuration before installing and running Kernel for OLM
to PST. Following are the minimum system requirements that a system should possess for successfully
installing the Kernel for OLM to PST software.
Basic System Requirements
Pentium Class Processor
Minimum 64 MB RAM (128 MB Recommended)
10 MB free disk space for software installation
Enough disk space to save recovered data

Supported Windows OS Platforms (Both 32-bit and 64-bit)
Windows 10
Windows 8.1
Windows 8
Windows 7
Windows Vista
Windows XP
Windows 2003
Windows 2000
Windows 98
Windows 95
Windows Server 2003 (All Service Packs)
Windows Server 2008
Windows Server 2008R2
Windows Server 2012
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Supported MS Outlook Versions (Both 32-bit and 64-bit)
MS Outlook 97
MS Outlook 98
MS Outlook 2000
MS Outlook 2003
MS Outlook 2007
MS Outlook 2010
MS Outlook 2013
MS Outlook 2016
MS Outlook 2019
Supported Outlook for Mac: All Versions
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2. Getting started with the User Interface
2.1 Welcome Screen of the Software
Kernel for OLM to PST software offers user-friendly, attractive graphical user interface. When the software
is launched, “Source file selection” pop-up window appears by default.

Figure 2.1: Welcome Screen of Kernel for OLM to PST Software
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2.2 Menu Bar
The Menu bar of Kernel for OLM to PST comprises only four menus:
File Menu
View Menu
Help Menu

File Menu
File menu of the Kernel for OLM to PST software appears, as shown in the following figure:

Figure 2.2: File Menu

Following table enlists the options available in the File menu:
Option

Description

Select File

Opens dialog box to browse and select OLM file

Save

Saves the output data at specific location

Exit

Exits from the application

View Menu
View menu of the Kernel for OLM to PST software appears, as shown in the following figure:

Figure 2.3: View Menu

Following table enlists the option available in the View menu:

Help Menu

© KernelApps Private Limited

Option

Description

Status Bar

Hides or displays the Status Bar

Kernel for OLM to PST

Installation & Configuration Guide

Help menu of Kernel for OLM to PST software appears, as shown in the following figure:

Figure 2.4: Help Menu

Following table enlists the options available in the Help menu:
Option

Description

About

Displays support information about the software

Software Help

Launches user‟s help manual for Kernel for OLM to PST

2.3 Tool Bar
The Tool bar is displayed just below the Menu bar section of the software interface and consists of buttons that
work as shortcuts for various options available in the main menu of the software. The buttons assists users to
easily perform the operations that can also be performed by Menu bar options. Following table enlists the
buttons available on the Tool bar of the Kernel for OLM to PST software:
Button

Button Name
Description
Select File
This button opens dialog box to browse and select corrupt OLM file.

Find

This button opens dialog box to search OLM file

Save

Click this button to save the recovered data at specified location.

Help

Click this button to launch user‟s help manual of the software.

2.4 Left Pane
The left pane of Kernel for OLM to PST software displays the retrieved folders of OLM file in a tree-like
structure. You can view the retrieved folders and navigate through them.
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Figure 2.5: Left Pane

2.5 Right Pane
The right pane of Kernel for OLM to PST displays the email items in the folder or file selected from the Left
Pane. The Right Pane is again divided into two different panes (as shown in the images below):

Figure 2.6: Right Pane displaying items of a selected folder
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Figure 2.7: Right Pane displaying details of selected email item
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3. Install and Uninstall
3.1

Installing Kernel for OLM to PST

After being familiar with the software overview, key features, and system requirements let us install the Kernel
for OLM to PST software. The software is easy to install and involves few simple steps to configure it.
However, before installing the software make sure that the software installer file is available on your computer.
If the file is not available on your computer then you can download it from our Website:
https://www.nucleustechnologies.com/olm-to-pst.html
After you have downloaded the installer file, execute the following steps to install the software:
1. Double-click the Kernel for OLM to PST installer file.
2. Follow the on-screen instructions. When the installation process completes “Setup Installation
Complete” message appears on the software installation screen.
3. Click the Finish button to launch the software.
After you have completed the software installation process, a shortcut to start the software will be added in
the Windows Start program menu. You can start the software from Windows Start program menu. You can
also create desktop icon of the software from where you can start the software by double-clicking the icon.

3.2 Uninstalling Kernel for OLM to PST
Kernel for OLM to PST software can be uninstalled from the computer system by using one of the
following two methods:
Uninstall from Windows Start Menu
Uninstall from Control Panel

 Note: Before starting the uninstallation process, make sure that the Kernel for OLM to PST
software is not in use.
Uninstall from the Windows Start menu
Execute the following steps to uninstall Kernel for OLM to PST from Windows Start menu:
1. Click Start > All Programs > Kernel for OLM to PST > Uninstall Kernel for OLM to PST. A warning
message before uninstalling the software will be displayed on the screen.
2. Click Yes button to uninstall the software.
3. Click OK button.
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Kernel for OLM to PST is successfully uninstalled from your computer system.
Uninstall from Control Panel
Execute the following steps to uninstall Kernel for OLM to PST from Control Panel:
1. Click Start > Control Panel. The Control Panel window appears.
2. Double-click the Add or Remove Programs icon. A list of the programs installed on your computer
system appears.
3. Select Kernel for OLM to PST and click the Remove button. A warning message before uninstalling
the software will be displayed on the screen.
4. Click Yes button to uninstall the software.
5. Click OK button.
Kernel for OLM to PST is successfully uninstalled from your computer system.
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4. Using Kernel for OLM to PST
4.1 Converting OLM File
Using Kernel for OLM to PST, you can easily and effectively convert Outlook for Mac OLM files to MS Outlook
PST files. To convert OLM to PST or access data of corrupted OLM file, you have to first extract the data
from OLM file. Follow the basic steps given below to retrieve data from OLM file:
Step 1: Click Start > All Programs > Kernel for OLM to PST > Kernel for OLM to PST to launch the
software. The main window of the software appears.

Figure 4.1: Main Window of the software after launching the product

The Source file selection' interface appears by default.

 Note: You can also get the interface by clicking Select button from the Tool Bar. You can
also select Select File option from the File Menu.

Step 2: Click the Browse button to select the location of OLM file. In case you don't know the exact location
of the file, click Search button to search the OLM file. The 'Search OLM File(s)' dialog box appears.
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Figure 4.2: Search OLM File Interface

Step 3: Click the Browse button to select the folder where you want to search for the OLM file.

Figure 4.3: Searching for OLM file
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Step 4: After selecting the required drive, click the Search button. The Software starts searching for OLM
file. After searching, the software will enlist the OLM files found in the selected drive.

Figure 4.4: Enlisting the files found in the selected drive

Step 5: Select the required OLM file and click OK button. The selected OLM file gets selected in the 'Select
Source OLM File' text area.
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Figure 4.5: Figure depicting selected OLM file

Step 6: Click Next to proceed. A dialog box is displayed after successful completion of scanning and data
retrieval from OLM file.
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Figure 4.6: Displaying successful completion of scanning process

Step 7: All the folders are enlisted in a tree-like structure in the left pane.
Step 8: Select any folder from the left pane to view the items. The items are displayed in the right pane. You
can select any item from the right pane and view its details which are displayed just below the items in the right
pane.
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Figure 4.7: Displaying details of retrieved data

4.2 Searching OLM File
Using Kernel for OLM to PST you can easily search required items from recovered OLM file and save the
found items in MSG or EML format to desired location. You need to execute the following steps to search
items from OLM file:

Step 1: Click on the Find option on toolbar. Find Messages(s) dialog box appears. Select the folders that
you want to search from the left-pane.
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Figure 4.8: Searching for OLM Files

Step 2: Specify the Search criteria. You can specify following search criteria: From, To, Subject, Received
before, Received after, Message has attachments or not.

Figure 4.9: Specifying the Search Criteria
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Step 3: Click on Find Now option to begin the search. As search progresses, all items matching specified
criteria are displayed in the bottom pane. At any time, you can click on Stop button to terminate the search
process.

Figure 4.10: Searching in Progress
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Step 4: After the Search process gets finished, a message is displayed showing total number of items
found. Click on OK to complete the process.

Figure 4.11: Displaying Searched Items
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Step 5: To save the found messages, right-click on the required message and multiple saving options get
displayed. Select any of these options as per your requirement.

Figure 4.12: Saving Options for Searched Items
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4.3 Saving Output File
After retrieval of OLM data, you can preview the retrieved folders displayed in the left pane. Once you view
the folders and their item details, you have to save them at specific locations in the hard drive. You can save
the recovered items in PST, MSG, EML, and other formats. Here, we have described three formats. After
saving the items, they become accessible with MS Outlook and Outlook Express.
Save as PST
Save as MSG
Save as EML

4.3.1

Save as PST

To save the recovered items in PST, follow the steps given below:
Step 1: Select the folders from the left pane that you want to save and click Save. The Select Output Type
window will appear on the screen. Select the PST option and click Next.

Figure 4.13: Selecting PST File option to convert the OLM file
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Step 2: The filter section window will appear on the screen. Here, you can apply multiple filters to the
OLM file based on the following criteria.
• From – To specify the sender name
• To – To specify the receiver name
• Subject – To specify a specific subject
• Folder Name – Select the specific folders from the file
• Item Type – Select the items of the file that you want to convert
• Date Range – To select a specific date range for converting the OLM file
After applying the specific filters, click Next

Figure 4.14: Applying filters to the OLM data
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Step 3:The Manage Recovered Data window will appear on the screen. Here, you can split the PST file if you
want to , or leave it as it is. Also, you can check 'Attach prefix to store name' checkbox if you want to add
prefix, and then click Next.

Figure 4.15: PST file Split options

Step 4: Click Next button to proceed. The 'Select Destination Path’ interface opens.
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Figure 4.16: Selecting a destination path to save the PST file

Step 5: After specifying the exact location to save PST, check the checkbox ‘Exclude deleted items while saving’ and
click Finish.
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Figure 4.17: Specifying a location to save the PST file

Step 6: Once you click Finish, the tool will start converting OLM files to PST.

Figure 4.18: Saving the converted PST files to exact location
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Step 7: Once the files are saved at exact location, a notification will appear on your screen with a confirmation
message.

Figure 4.19: Notification displayed after saving the file

You can click the link of the destination folder to view its contents. Else, select the saved file and click OK to view
its contents.
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Save as MSG

Like PST, the retrieved data can be saved in MSG format also. You need to follow the following basic steps
to save the data as MSG file:
Step 1: Select the folders from the left pane that you want to save and click Save. The Select Output
Type window will appear on the screen. Select the MSG option and click Next.

Figure 4.20: Selecting MSG option from the Output type
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Step 2: The filter section window will appear on the screen. Here, you can apply multiple filters to the OLM file
based on the following criteria.
• From – To specify the sender name
• To – To specify the receiver name
• Subject – To specify a specific subject
• Folder Name – Select the specific folders from the file
• Item Type – Select the items of the file that you want to convert
• Date Range – To select a specific date range for converting the OLM file
After applying the specific filters, click Next

Figure 4.21: Applying specific filters to the OLM file
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Step 3: A dialog box is displayed asking for selecting the saving path location to save MSG file. Click Browse
button to provide the location for saving the file.

Figure 4.22: Selecting a destination path to save the MSG file

© KernelApps Private Limited

Kernel for OLM to PST

Installation & Configuration Guide

Step 4: After specifying the exact location to save MSG, check the checkbox ‘Exclude deleted items while saving’
and click Finish.

Figure 4.23: Specifying the location for saving the MSG file
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Step 5: After clicking Finish, the tool will start converting OLM files to MSG.

Figure 4.24: Software converting OLM data to MSG format
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Step 6: Once the files are saved at exact location, a notification will appear on your screen with a confirmation
message.

Figure 4.25: Showing the saved result at desired location
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4.3.3 Save as EML
The recovered data can be saved in MSG format also. Follow the steps given below to save the items in
EML format:
Step 1: Select the folders from the left pane that you want to save and click Save. The Select Output
Type window will appear on the screen. Select the EML option and click Next.

Figure 4.26: Selecting EML option from Output type
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Step 2: The filter section window will appear on the screen. Here, you can apply multiple filters to the OLM file
based on the following criteria.
• From – To specify the sender name
• To – To specify the receiver name
• Subject – To specify a specific subject
• Folder Name – Select the specific folders from the file
• Item Type – Select the items of the file that you want to convert
• Date Range – To select a specific date range for converting the OLM file
After applying the specific filters, click Next.

Figure 4.27: Applying specific filters to the OLM data

.

© KernelApps Private Limited

Kernel for OLM to PST

Installation & Configuration Guide

Step 3: A dialog box is displayed asking for selecting the saving path location to save EML file. Click Browse
button to provide the location for saving the file.

Figure 4.28: Specifying a Saving Path for the EML files
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Step 4: After specifying the exact location to save EML, check the checkbox ‘Exclude deleted items while
saving’ and click Finish.

Figure 4.29: Finalizing a location to save EML file
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Step 5: After clicking Finish, the tool will start converting OLM files to EML.

Figure 4.30: Software saving OLM file to EML format
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Step 6: Once the files are saved at exact location, a notification will appear on your screen with a confirmation
message

Figure 4.31: Displaying the location for saved EML files
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5. Download, Purchase and Register
5.1 Free Trial Download
The trial version of Kernel for OLM to PST is also available for free of cost, using which a user can evaluate
and analyze the capabilities of the software before making actual purchase. Free version of Kernel for OLM
to PST works almost similar to that of the full version. Using the trial copy, user can retrieve entire data from
OLM file and can preview the recovered items, but can save only 10 items from each folder into PST file. For
saving the entire items, purchase the full version of the software.
Free version of Kernel for OLM to PST can be downloaded from our safe and
secure website: https://www.nucleustechnologies.com/download-olm-to-pst.html

5.2 Purchase & Register
Purchase the Full version of Kernel for OLM to PST software for retrieving email items from OLM file and
saving them in PST file format. The FREE trial version of Kernel for OLM to PST software allows you to
preview the recovered items but limits from saving all the recovered items.
Purchase the Full version of Kernel for OLM to PST software through our encrypted and secure Website:
https://www.nucleustechnologies.com/buy-olm-to-pst-conversion.html
Payment and Delivery
Purchase the Kernel for OLM to PST software from our authorized resellers, which provide number of
payment options for your ease - PayPal, FAX, Credit Card, E-cheque, Pay Order, etc.
After making the purchase transaction with our resellers, an email is sent consisting of activation details and
download link for the Full version of Kernel for OLM to PST comprising of the activation code. This email is
sent to the email address, which you have used while processing the purchase transaction with our resellers.
We suggest you not to use false email address while making the purchase transaction.
For any other details related to purchase process, software activation process, email us at:
sales@nucleustechnologies.com

5.3 Support
KernelApps Pvt. Ltd. provides round-the-clock technical support for its product range to solve technical and
software queries. The software comes with an embedded user help manual that can be accessed by clicking
Help in the software main window. You can also press the F1 key on the keyboard of your computer to access
the embedded user help manual of Kernel for OLM to PST.
We also have live support wherein you can chat with our software experts at:
https://www.nucleustechnologies.com/supportcenter/
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6. Troubleshooting
6.1 Common Issues
What is the limitation in trial version of Kernel for OLM to PST?
The trial version of Kernel for OLM to PST works almost same as that of the full version of the software but has
some limitation. Using the trial copy, user can retrieve entire data from OLM file and can preview the recovered
email items, but can save only 10 items from each folder into PST file.

6.2 Frequently Asked Questions
1. What are the major reasons for corruption of Outlook for Mac OLM files?
Major reasons for corruption of Outlook for Mac OLM files include unintentional formatting of the HDD,
error while Outlook installation, malware attack, hardware error, etc.
2. How to purchase Kernel for OLM to PST?
One can purchase Kernel for OLM to PST using our safe, secure and encrypted Website:
https://www.nucleustechnologies.com/buy-olm-to-pst-conversion.html
3. What are the three saving modes in Kernel for OLM to PST?
Kernel for OLM to PST offers three saving modes- Save as PST, Save as MSG and Save as EML.
4. What are the supported Windows OS Platforms for Kernel for OLM to PST software?
The supported Windows OS Platforms for Kernel for OLM to PST software are: Windows Server 2003,
Windows Server 2008, Windows Server 2008R2, Windows Server 2012, Windows 8, Windows 7,
Windows Vista, Windows XP, Windows 2003, Windows 2000, Windows 98, and Windows 95.
5. What are the supported MS Outlook versions for Kernel for OLM to PST software?
The supported MS Outlook versions for Kernel for OLM to PST are MS Outlook 97, 98, 2000, 2003, 2007,
2010, and 2013 (Both 32 bit and 64 bit).
6. Give the basic steps for OLM to PST conversion process.
The software performs the conversion process from OLM to PST in three simple steps - Takes the OLM

file as input, Recovers data from the OLM file, and Restores them in PST file of Outlook.
7. Give the link for downloading the free trial version of Kernel for OLM to PST software.
The free trial version of Kernel for OLM to PST software can be downloaded using the link:
https://www.nucleustechnologies.com/download-olm-to-pst.html
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7. Legal Notices
This section comprises the legal specification about Kernel for OLM to PST and the company
KernelApps Private Limited.

7.1 Copyright Notice
KernelApps Private Limited, Kernel for OLM to PST, accompanied user manual, and documentation are
copyright of KernelApps, with all rights reserved. Under the copyright laws, this user manual cannot be
reproduced in any form without the prior written permission of KernelApps. No Patent Liability is assumed,
however, with respect to the use of the information contained herein.
© KernelApps PVT LTD. All rights reserved.

7.2 Trademarks
Kernel for OLM to PST ® is a copyright work of KernelApps Private Limited.
Windows 7®, Windows Vista®, Windows XP®, Windows 2003®, Windows 2000®, Windows 98®, and
Windows 95® are registered trademarks of Microsoft Corporation. All other brand and product names are
trademarks or registered trademarks of their respective companies.

7.3 Disclaimer
The information contained in this user manual, including but not limited to any product specifications
is subject to change without notice. KernelApps Private Limited provides no warranty with regard to this user
manual or any other information contained herein and hereby expressly disclaims any implied
warranties of merchantability or fitness for any particular purpose with regard to any of the foregoing.
KernelApps Private Limited assumes no liability for any damages incurred directly or indirectly from any
technical or typographical errors or omissions contained herein or for discrepancies between the product
and the user manual.
In no event shall KernelApps Private Limited be liable for any incidental, consequential special, or exemplary
damages, whether based on tort, contract or otherwise, arising out of or in connection with this user manual
or any other information contained herein or the use thereof.

7.4 License Agreement
Kernel for OLM to PST © by KernelApps Private Limited.
Your Agreement to this License
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u should carefully read the following terms and conditions before using, installing, or distributing this
software, unless you have a different license agreement signed by KernelApps Private Limited. The
terms and conditions of this License describe the permitted use and users of each Licensed Copy of
Kernel for OLM to PST. For purposes of this License, if you have a valid license, you have the right to use
a single Licensed Copy of KernelApps.
Scope of License
Each Licensed Copy of Kernel for OLM to PST may either be used by a single person or used nonsimultaneously by multiple people who use the software personally installed on a single workstation. All
rights of any kind in the KernelApps, which are not expressly granted in this License, are entirely
and
exclusively
reserved to and by KernelApps. You may not rent, lease, modify, translate, reverse
engineer, decompile, disassemble, or create derivative works based on, KernelApps, nor permit anyone else to
do so. You may not make access to KernelApps available to others in connection with a service
bureau, service provider, or similar business, nor permit anyone else to do so.
application
Warranty Disclaimers and Liability Limitations
Kernel for OLM to PST, and any and all accompanying software, files, data and materials, are distributed
and provided as is and with no warranties of any kind, whether expressed or implied. In particular, there is
no warranty for the quality of data recovered. You acknowledge that good data processing procedure
dictates that any program, including Kernel for OLM to PST, must be thoroughly tested with non-critical
data before there is any reliance on it, and you hereby assume the entire risk of all use of the copies of
Kernel for OLM to PST covered by this License. This disclaimer of warranty constitutes an essential part
of this License. In addition, in no event does KernelApps authorize you or anyone else to use Kernel
for OLM to PST in applications or systems where Kernel for OLM to PST Failure to perform can
reasonably be expected to result in a significant physical injury, or in loss of life. Any such use is entirely
at your own risk, and you agree to hold KernelApps harmless from any and all claims or losses
relating to such unauthorized use.
General
This License is the complete statement of the agreement between the parties on the subject matter, and
merges and supersedes all other or prior understandings, purchase orders, agreements, and
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and
you consent to such jurisdiction and venue. There are no third-party beneficiaries of any promises,
obligations, or representations made by KernelApps herein. Any waiver by KernelApps of any
violation of this License by you shall not constitute, nor contribute to, a waiver by KernelApps of any
other or future violation of the same provision, or any other provision, of this License.
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